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Copyright               
© Copyright 2006                           
Apptec Corporation                  
All Rights Reserved 

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any 
form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the 
prior written consent of Apptec Corporation. 

Trademarks                        
Apptec Corporation, the Apptec Corporation logo, and Personal Logger are trademarks or 
registered trademarks of Apptec Corporation. 

All other trademarks or registered trademarks are the property of their respective companies. 

Conventions                           
Items in BOLD and ITALIC typeface should be given special attention.               

Changes             
Apptec Corporation reserves the right to make changes to its products and specifications at any 
time.  Information furnished by Apptec Corporation is believed to be accurate, but no 
responsibility is assumed by Apptec Corporation for any result from the use of said information. 

License Terms And Conditions          
GEMINI SYSTEM SOFTWARE is licensed to you under the terms and conditions contained in the 
END USER LICENSE AGREEMENT located on your system’s hard drive at the path 
“Gemini\PersonalLogger\License.rtf”.  PLEASE READ THIS LICENSE CAREFULLY BEFORE 
USING THIS SOFTWARE.  BY USING THIS SOFTWARE YOU ARE AGREEING TO BE 
BOUND BY THE TERMS OF THIS LICENSE. 
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INTRODUCTION 

Personal Logger is a professional logging solution that enables you to record 
audio files on you own computer from virtually any input source.  It works with the 
sound card in your computer, and can record all audio or only audio that is above 
a selected threshold.  Personal Logger organizes your log files so that you can 
record telephone conversations, interviews and conferences with ease and so 
you can find specific logs quickly when you need to.   
 
Personal Logger is ready to accept audio from your computer’s microphone, an 
external microphone, a conference microphone, a telephone recording adapter, 
or from virtually any source of audio. 
 
Personal Logger makes it easy to record important phone calls.  Just press one 
button to begin recording or use the Voice Activated Recording feature to 
automatically record all phone calls.  You can mark important calls PROTECTED 
and allow the others to be automatically deleted after a set number of days. 
 
Personal Logger also makes it easy to review your recorded log files.  Its 
playback mode lets you adjust the playback speed and volume, mark important 
logs PROTECTED, and delete selected logs. 
 
• Record audio from microphones and telephone recording adapters.  
  
• Record effortlessly using Voice Activated Recording or manual control. 
 
• Mark important logs PROTECTED (from automatic aged deletion). 
 
• Playback log files to review and manage them. 
 
• Adjust recording threshold, playback speed, and volume with ease.   
 
• Never miss recording another important phone call or meeting! 
 
• Record inbound and outbound phone calls. 
 
• Record conferences, meeting minutes, and interviews. 
 
• Record lectures, sermons, and public meetings. 
 
• Record ambient sounds to monitor home and office security. 
 
• Record the activities of a new babysitter. 
 
• Record 911, customer service, and order entry calls. 
 
• Use Pedal Magic to use a foot pedal to transcribe with the Log Player. 
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VOICE ACTIVATED RECORDER 

Personal Logger initially displays the Voice Activated Recorder.  

 
Set the Recording Threshold slide to the desired threshold.  Position it all the way 
to the left to record all audio regardless of how soft.  Set it higher to record only 
audio that is at a level above the set threshold. 
 

 
When you press RECORD a log file name that consists of the current date and 
time will automatically be created.  If you wish to enter a descriptive name do so 
before you press record.  The current date and time will automatically be added 
to your descriptive name.   
 
The log file length indicator at the right of the log file name shows the length of 
the log file in hours, minutes and seconds. 
 
The RECORD key will glow yellow and indicate “--- RECORD STANDBY ---“, and 
the log file length indicator will not increment when the incoming audio level is 
lower than the set threshold.  The RECORD key will glow red and indicate “--- 
RECORDING ---“, and the log file length indicator will increment when the 
incoming audio level is greater than or equal to the set threshold. 
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When the voice activated recorder is minimized, it will display a Red indicator 
and show “RECORDING” in the task bar when it is recording and the incoming 
audio level is greater than or equal to the set threshold.  It will display a Yellow 
indicator and show “STANDBY” in the task bar when it is recording and the 
incoming audio level is less than the set threshold. 
 
Press STOP to stop recording, and then press RECORD to resume recording.  
The threshold can be changed anytime, even while recording. 
 
Press START NEW LOG to close the current log.  You may then enter a log file 
description, if desired, and press RECORD to begin a new log file. 
 
After recording and pressing STOP, the Edit menu is available to “Protect and 
Start New Log” or “Delete”.  Press “Protect and Start New Log” to close the 
current recording and to mark it PROTECTED.  A protected log file is excluded 
from the automatic deletion of old log files.  Press “Delete” to delete the current 
log file.  You will be asked to confirm this. 
 

 
Also after recording and pressing STOP the File menu is available to switch to 
the “Log Player”.  Press “Log Player” to switch to the Log Player.  See the next 
page for details about using it. 
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LOG PLAYER 

When OPEN LOG is pressed the Personal Logger displays the Log Player. 
 
If OPEN LOG is pressed after recording, the current log file will be automatically 
opened for playback.   

 
If OPEN LOG is pressed without a new recording having been made, an Open 
Log File dialog will be displayed from which a log file can be selected. 
 
To play a log file, left-click to highlight it and then click Open, or double left-click 
it.  To rename or delete a log file, left-click to highlight it and then right-click to 
select rename or delete.  
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Once a log file has been opened it can be played. 
 
Press PLAY to begin playback, 
STOP to pause playback, REW 
to engage rewind, FF to engage 
fast forwarding, |< to skip to the 
beginning, or >| to skip to the 
end. 
 
You may also adjust the 
VOLUME and SPEED slides, 
and click on the word SPEED to reset the speed control to its center position 
(normal speed). 
 
You may also adjust the position-in-file indicator/slide to move to a different 
position in the file. 
 
The Edit menu allows selection of “Protect” or “Unprotect”, or “Delete”. 
 
Press “Protect” to mark the 
current recording PROTECTED.  
A protected log file is excluded 
from the automatic deletion of 
old log files.  If you selected a 
PROTECTED log file the Edit 
menu option will show 
“Unprotect” instead of “Protect”.  
You may press “Unprotect” to 
unmark it as PROTECTED. 
 
Press DELETE to delete the current log file.  You will be asked to confirm this.  If 
a log file is marked PROTECTED you must press “Unprotect” before you may 
delete it. 
 
Press OPEN A LOG FILE to open a different log file. 
 
Press BACK TO RECORDER or from the File menu press “Voice Activated 
Recorder” to return to the Voice Activated Recorder. 
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CONFIGURATION  

The configuration menu contains adjustments and special features with which 
you can fine-tune the operation of the Personal Logger. 
 

Start new log after silence:  The current 
log file will be closed and a new log file will 
automatically begin recording when the 
number of seconds of silence (audio input 
that is below the set threshold) has 
elapsed.  Adjust from 1 to 999 seconds; 
set to 0 to disable. 
 
Maximum record time:  The number of 
minutes a log file can become before it is 
automatically paused (if the “Start new log 
at maximum record time” is not selected).  
Adjust from 1 to 999 minutes; set to 0 to 
disable.  When the Maximum Record Time 

has elapsed it will notify you with a tone and a pop-up message (if the “Start new 
log at maximum record time” is not selected). 
 
If the “Start new log at maximum record time” is selected, when the Maximum 
Record Time has elapsed the current log file will be closed and a new log file will 
automatically begin recording. 
 
Start new log at maximum record time:  The current log file will be closed and 
a new log file will automatically begin recording when the Maximum Record Time 
has elapsed (if the Maximum Record Time is set greater than 0). 
 
Automatically delete old log files:  Log files this many days old (and not 
marked as PROTECTED) will be automatically deleted.  Adjust from 1 to 99 
days; set to 0 to disable. 
 
Start recording by default:  Automatically engage recording when Personal 
Logger is started and when START NEW LOG is pressed. 
 
Run in stealth mode:  Personal Logger will ensure “Start recording by default” is 
enabled and will start hidden.  To make it visible create a folder at “c:\” called 
“ExitLoggerStealthMode”.  
 
Stay on top of all other applications:  Personal Logger will stay in the forefront 
of all other applications. 
 
Minimize Upon Startup:  Personal Logger will start minimized. 
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Input Device:  Select your computer’s 
sound card as the source of audio. 
 
Input Line:  Select your computer sound 
card’s input line as the source of audio. 
 
Frequency:  Select the desired recording 
frequency.  Lower frequencies conserve 
hard drive space, higher frequencies record 
with increased clarity.  Select from 8 KHz, 
11.025 KHz, 16 KHz, 22.05 KHz, 24 KHz, 32 
KHz, 44.1 KHz, or 48 KHz. 
 
All recordings are made in 16-bit stereo 
WAV format. 
 
 
Enable Automatic Gain Control:  Enable automatic gain control for recording. 
 
Set to defaults:  Return the AGC settings to their defaults. 
 
AGC Low Level:  When AGC is enabled, the record gain will be increased when 
the audio level is less than this many dB.  Range is -92 dB to 0 dB; default is -40 
dB.  Should be set lower than the AGC High Level. 
 
AGC High Level:  When AGC is enabled, the record gain will be decreased 
when the audio level is greater than this many dB.  Range is -92 dB to 0 dB; 
default is -10 dB.  Should be set higher than the AGC Low Level. 
 
AGC Attack Time:  When AGC is enabled, this is the time for gain change by 20 
dB.  Range is 1 to 99 ms; default is 4 ms. 
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HELPFUL HINTS  

TELEPHONE RECORDING:  You can engage recording manually, or you can 
set Personal Logger to record all telephone conversations automatically to 
ensure you don’t miss recording an important one.   
 
To set it to record automatically when an inbound or outbound call is made, use 
“Start recording by default” and set the Recording Threshold near its low end. 
 
In this configuration, when Personal Logger is started it will begin in record 
standby mode listening for the next inbound or outgoing phone call.  When it 
hears audio it will automatically begin recording. 
 
When the call is over you may select “Protect and Start New Log” to protect it 
from automatic age based deletion, or just press START NEW LOG to close the 
file and automatically engage record standby mode to be ready to record the next 
phone call. 
 
To further enhance telephone call recording, if you don’t want to manually press 
START NEW LOG to close the current recording, you can use the “Start new log 
after silence” feature.  You may wish to set it between 10 and 20 seconds to help 
ensure that a new log file is not begun during lulls in your phone conversation, 
but is begun when the current call has finished and the line has returned silent for 
that period of time.  
 
If you place a new phone call or if a new phone call comes in before the set 
amount of silence time has elapsed, this call will be recorded in the same 
recording.  To ensure this doesn’t happen you may press START NEW LOG at 
the end of the call.   
 
CONFERENCE RECORDING:  You can use a single microphone to record a 
conference, an interview, or ambient sound.  You may also use two microphones 
to simultaneously record the audio from two sources since your Personal Logger 
records in stereo.  Using two microphones, one at each end of a conference 
table is a great way to help ensure everyone is clearly heard. 
 
If you’re recording a lecture or speech, using two wireless microphones is a great 
way to record the speaker and audience questions with great clarity. 
 
To record ambient sounds when you wish to monitor the security of a home or 
office or perhaps to record the activities of a new babysitter, the use of one or 
two wired or wireless microphones can work very well to cover wide areas. 
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RECORDING HYSTERESIS:  When the level of audio falls below the set 
threshold it will take a second or two until the recording pauses.  This is normal 
and helps to ensure that soft passages in a conversation will not prematurely 
trigger record standby mode. 
 
PLAYBACK LEVEL AND RECORDING INPUT SOURCE AND LEVEL:   
 
 
 
 
 
 
 
 
Use Microsoft’s Master Volume Control to 
set the initial playback volume. 
 
Be sure to set both the Wave and Master 
Volume levels, and ensure that neither is 
muted.   
 
 
 
 
 
 

 
 
 
 
 
 
Use Microsoft’s Master Volume Control’s 
Options/Properties menu selection to set the 
initial recording gain (volume) and to select the 
input source. 
 
Before you set the record gain turn Personal 
Logger’s AGC off.  Turning Personal Logger’s 
AGC on will force the record gain to maximum. 
 
Use the Advanced key to select Microphone 
Boost if you desire to raise the recording gain to 
its highest potential. 
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AUTOMATICALLY DELETE OLD LOG FILES:  Each time Personal Logger is 
started it deletes log files that are equal to or older than the number of days set in 
this feature, bypassing log files marked as protected.   
 
This feature is great for holding log files for a period of time until you determine if 
they are worthy of saving (protecting).  Those that are not marked as protected 
are automatically deleted to conserve your computer’s drive space. 
 
START RECORDING BY DEFAULT:  Each time Personal Logger is started, 
each time START NEW LOG is pressed, each time “Protect and Start New Log” 
is selected, and each time “Voice Activated Recorder” is selected or each time 
BACK TO RECORDER is pressed, recording is automatically started. 
 
This feature supports Stealth Mode operation by automatically engaging record 
each time Personal Logger is started.  When using “Run in stealth mode” 
Personal Logger should be placed into Windows’ Start menu so that it is 
automatically started each time the computer is booted or rebooted. 
 
RUN IN STEALTH MODE:  Each time Personal Logger is started it will run 
without displaying its splash screen or main menu.  It will also not show in the 
task bar, and it will automatically start recording. 
 
This feature supports security monitoring and private investigations by invisibly 
and silently recording telephone conversations or ambient discussions. 
 
When using “Run in stealth mode” Personal Logger should be placed into 
Windows’ Start menu so that it is automatically started each time the computer is 
booted or rebooted. 
 
To exit stealth mode you must create a folder at “c:\” called 
“ExitLoggerStealthMode”.  Stealth mode will be exited within 10 seconds. 
 
SAVING PLACEMENT ON YOUR DESKTOP:  The current placement of 
Personal Logger on your desktop will be automatically saved 
 
This feature is great for keeping it in the corner of your desktop so as not to 
disturb the view of another application. 
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STANDARD VERSUS ADVANCED MODE 

Personal Logger runs as a Standard Edition until a Stationary License Key is 
entered into the Upgrade menu, or until a Floating License Key is connected to 
your computer. 
 
The Standard Edition limits record time to 1 minute per log file and disables the 
advanced features. 
 
The Advanced Edition has no record time limits and enables the advanced 
features. 
 
The additional features available in the Advanced Edition include: 

• Starting a new log file after silence is detected. 
• Setting maximum record time to 0 (for unlimited recording) or above 1 

minute. 
• Starting a new log file when the maximum record time has elapsed. 
• Automatically deleting a log file that is older than x days. 
• Automatically engaging record mode. 
• Engaging stealth mode. 
• Disabling staying on top of all other applications. 
• Enabling minimizing upon startup. 
• Setting higher frequency recording parameters. 
• Enabling and customizing Automatic Gain Control. 
• Enabling playback speed control. 
• Automatic saving of the current placement on your desktop. 
• Allowing annotation of the description of each log file in addition to the 

date/time stamp. 
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